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Starting the application

You can start a look by clicking on start and choosing all programs Microsoft office and Microsoft office 2010.

The Outlook 2010 window
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The Outlook window also contains elements that are specific to the Outlook application. These
elements include a Navigation pane, a Folder pane, a Reading pane, and a To-Do Bar. The
Navigation pane shows the active pane and a set of buttons for switching the active pane. The
Folder pan displays the Folder Contents list. The Reading pane displays emails. The To-Do Bar

displays the Date Navigator, upcoming appointments, and tasks.
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Expanding and minimizing a pane

You can collapse and expand the Navigation pane and To-Do Bar by clicking the
sidewayspointing caret-shaped buttons at the top of those panes. If the pane is expanded,
clicking the button minimizes the pane. A minimized pane shows summary information and key
buttons. If the pane is minimized, clicking the button expands the pane to show its full
complement of information and commands.

Resizing a pane

You can increase or decrease the width of an individual pane in the program window. To do so,
point the border of the pane so that the pointer appears as a double-headed arrow, and then
drag the border to the left or right.

The Navigation pane
The Navigation pane provides centralized navigation to all parts of Outlook. The top section
displays the active Outlook pane, and the bottom section contains the pane switching buttons.
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Default panes

Outlook provides several default panes where
you can access folders or shortcuts specific to
each pane. You can access each pane by clicking
the pane-switching buttons in the Navigation

pane.
Available panes
e Mail
e Calendar
e (Contacts
e Tasks
e Notes
e Folder
e Shortcuts
e Journal

Collapsing and expanding the
Navigation pane

You can free up space in your Outlook windows
by collapsing the Navigation pane. To collapse
or expand the Navigation pane, either click the
sideways-car=et symbol (< or >) at the top
corner of the pane, or click the View tab and
choose Normal, Minimized, or Off from the
Navigation Pane menu.
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Outlook folders

Outlook provides folders in which you can save and store the items you create. You can access
these folders by using the default panes within the Navigation pane. You can also access a
folder by clicking the Folder List icon in the Navigation pane and then clicking the folder you

want. You can use the default folders or create your own folders.
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The Reading pane
e Displayed only when a mail-related pane or folder is active
e Read contents of an item
e Preview and open attachments
e Follow a hyperlink
e Use voting buttons
e Respond to meeting requests

The Inbox

By default, all messages you receive are stored in the Inbox folder. This is one of the most
frequently used folders in Outlook. You can read messages stored in the Inbox. You can also
create and send messages and reply to messages.

Icon Description
4 New and unread message
3 Message that’s been read

Message that’s been read and replied to
Message that’s been read and forwarded
Message with a file attachment

= ¥ |

Additionally, a category indicator icon is shown for each message. By default, messages are
uncategorized, so the box-shaped icon is white. You can assign a category in which case the
icon will be blue, red, or one of the other available colors.
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Creating Messages

The Bcc box

Recipients can see who a message is sent to by looking at the e-mail header in the Outlook
window. This is also true when you include a recipient on the cc line, However, you can send
a“blind carbon copy” (bcc) to a recipient. He or she will recive the copy, but none of the
reipients will see the name on the To or CC lines.

Selecting the message format

By default, new messages are composed in HTML format. HTML formatting in messages
enables you to apply character and paragraph formats to your message’s body text.

Formatting messages
Message tab on Ribbon in Message window
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=, Keep Source Formatting
-f'"‘f_f’ (preserves the original text formatting)

Keep Text Only
A (cleans the text and removes all original formatting)

: Merge Formatting
F'h’.ir (matches the text around it)

Use Destination Theme
ﬂ (when copying between documents changes to the
standard styles for the new document)

Working with messages

Outlook provides a variety of tools for managing your email messasges.
e Reply
e Forward
e Delete and Restore

Replying to a message
e Reply — Creates a return message addressed only to the sender
e Reply All — Creates a return message addressed to the sender and everyone who
received a carbon copy of the original message.

Forwarding a message

By default, when you forward a message, you're really creating a new message. And in that new
message, the entire original message is included in the body text, with the insertion point at
the top of the new message. You can change this behavor using the Outlook Options dialog

box.

To open the dialog box, click the File tab and then click Options. In the left pane, click Mail to
display the mail properties that you can configure. Scroll to the “Replies and Forwards” section.
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Replies and forwards

“&l = [] Open replies and forwards in a new window
= Close original message window when replying or forwarding

[] Preface comments with: |Don Bremer

When replying to a message: |=__| Include original message text E]
When forwarding a message: |=—| Include original message text E]
Preface each line in a plain-text message with:

Handling Attachments

You can attach any type of file to an email message in order to send the file o the recipient. For
example, you can send Word, graphics, sound, and movie files as attachements. You can attach
a single file or multiple files to a message.

By default, Outlook blocks potentially unsafe attachments, such as EXE and VBS.

-] Message || Spicearrangmentl.jpg (140 KB}

Specifying email reply addresses.
By default, when a recipient replies to an email message, the reply is sent to the original
sender’s address. However, when you send a message, you might want replies to be sent to a
different address.
1. Create a message
2. Open the message’s Properties dialog box:
a. Onthe Message tab, in the Tags group, click the Dialog Box Launcher. In the
dialog box, check “Have replies sent to.”
b. On the Options tab, in the More Options group, click Direct Replies To. In the
dialog box, “Have replies sent to” is checked automatically.
3. Next to “Have replies sent to,” specify the email address to which you want replies sent.
4. Click Close
5. Finish the message and click send.

Managing junk email
You might get unwanted or junk email messages, which can clog your Inbox if they’re nore
managed properly. Outlook provides various tools to help you manage such messages.

1. The Junk Email folder

2. The Junk Email Filter
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3. The Blocked Senders list
4. The Safe Senders list
5. Additional Options

The Junk email folder appears in the left-most column under your list of all mail folders. If you
have any junk messages, this folder will appear in bold with a number in parenthesis to its right
indicating the total number of messages.

Simply click on the Junk folder to view these messages. To permanently delete this mail, select
the Delete icon in the upper left of the Outlook Home tab while viewing an individual email, or
right-click on the Junk folder and select Empty folder from the menu that appears.
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. "ﬂ % Ignore x h Y| | [l Meeting
|J e B — - g

MNew MNew

Inbox -

(A2 Move to: ;

3 Team E-mq

Delete Reply Reply Forward B pmore -

E-mail Items All g Reply & D
New & Block Sender
4 Favorites Never Block Sender 0
L_| Inbox Never Block Sender's Domain (@example.com) . . ‘ P,
= ewest on top
U=d Sent Iten Mever Block this Group or Mailing List
la] Deleted |
4 jd1234@mail.c @ Junk E-mail Options.. 8:02 PM
L] Inbox i il b
_,_I —4 CUMCIT Service Desk 7:30 PM
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The first options in the Junk drop down menu reference the specific message that is selected in
your mail Outlook window. For quick Junk mail filtering, select any of the following:
e Block Sender - automatically put any email from the sender's address into your Junk
Email folder.
e Never Block Sender - messages where the sender's email address is in the From field will
never be identified as Junk E-mail.
e Never Block Sender's Domain (@example.com) - any messages from that same domain
will not be filtered as Junk E-mail.
e Never Block this Group or Mailing List - messages that use a distribution list may have
the email address in the To, Cc or Bcc fields of the email you receive.
e In this case you would add them to the Safe Recipients List to ensure that messages
aren't filtered as junk mail.
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Search folders

In Outlook, you can use built-in Search folders
to find messages in a specific category or based
on a specific condition. For example, you could
use a Search folder to find all messages
containing specific text.

1. In the Navigation pane, click Mail

2. Right-click Search Folders and choose New
Search Folder

3. From the Select a Search Folder list, select a
condition

4. Click OK

Signatures

You can create personalized signatures for your
email

messages that include text, images, your
electronic

business card, a logo, or even an image of your
handwritten signature.

New Search Folder

RX

Select a Search Folder:
| Reading Mail Al

Unread mail
Mail either unread or marked as a task
Important mail

Mail from People and Lists
Mail from and to specific people
Mail from specific people
Mail sent directly to me
Mail sent to distribution lists

Organizing Mail v

Customize Search Folder:

Search mail in: Mailbox - bobbymoore v

[ OK I [ Cancel ]

1. Open a new message. On the Message tab, in the Include group, click Signature, and then

click Signatures.
2. Signatures command on the ribbon
3. On the E-mail Signature tab, click New.

4. Type a name for the signature, and then click OK.
5. In the Edit signature box, type the text that you want

to include in the signature.

@ J@ | [ 3® | ¥ FollowU
: ¥ HighIm
Attach Attach |Signature
File Item~ B § LowImp
Includy

Signatures... h

6. To format the text, select the text, and then use the style and formatting buttons to

select the options that you want.

Page 11 of 18




Add a signature to messages
1. Signatures can be added automatically to all outgoing messages, or you can choose
which messages include a signature.

b5 © -

HOME SEND / RECEIVE FOLDER VIEW GROUPS

: (T Ignor /~ ) 7, [ Meeti
..,':] [ Ignore x L_(_] (L—(_] [—__)1 - eeting

o = . Clean Up ~ = e : CCIM~
ew ew elete eply Reply Forwar
o - )
Email ltems~ &©Junk~ All E-[!] More
New Delete Respond

Under Choose default signature, in the E-mail account list, click an email account with
which you want to associate the signature.

3. In the New messages list, select the signature that you want to include.

4. If you want a signature to be included when you reply to or forward messages, in the
Replies/forwards list, select the signature. Otherwise, click (none).

Automatic replies

You might want to send automatic replies to the email messages you receive, such as when you
are out of the office on a business trip. You can use the Automatic Replies dialog box, formerly
called the Out of Office Assistant, to send such replies.

In order to process automatic replies, Outlook must be open and running on your computer or
you must use an Exchange Server. In an Exchange Server environment, it is the server, not
Outlook that manages the automatic replies.

©

s »Account Information

Open & Export

A .
U) Microsoft Exchange

* Add Account

Save As

E Account and Social Network Settings
ady Change settings for this account or set up more connections,
Account

Access this account on the web.
Settinas ~

1. Click the File tab, and then click the Info tab in the menu.
2. Inthe Automatic Replies dialog box, select the Send Automatic Replies check box.
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3. If you want to specify a set time and date range, select the Only send during this time
range check box.

4. Then set the Start time, and then set the End time.

5. Inthe Inside my organization tab, type the message that you want to send within your
organization, and in the Outside my organization tab, type the message that you want to
send outside your organization.

6. Click OK.

Office Account

Connect to social networks.

Options
bxit Automatic Replies (Out of Office)
€ Use automatic replies to notify others that you are out of office, on vacation, or
Automatic not available to respond to e-mail messages.
Replies

= Mailbox Cleanup

Manage the size of your mailbox by emptying Deleted Items and archiving.
Cleanup i
Tools ~ ————————

844 MB free of 4.5 GB

Setting Rules

A rule is an action that Microsoft Outlook takes automatically on an arriving or sent message
that meets the conditions that you specify in the rule. You can choose many conditions and
actions by using the Rules Wizard.

Rules fall into one of two categories — organization and notification. Rules don’t operate on
messages that have been read, only on those that are unread.

Creating Rules

You can create rules in at least two ways. If you have an email message that meets the criteria
you want to use in your new rule, you can select that message, click Rules, and choose Create
Rule. Alternatively, you can start the Rules Wizard by clicking Rules, choosing Manage Rules &
Alerts, and clicking New Rule

Calendar — Appointments
e Click on the Mail bar at the bottom of the Mail Folders view
e You may select a day, week, or month view from the menu at the top of Outlook.
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Creating new appointments

e Navigate to the appropriate day

e Drag through the time you want for the appointment

e Click on the “New” appointment button on the toolbar, or press CTRL-N
Fill in the Subject
Type in a Location
Date/Time is automatically filled in because you selected the day/time first
Reminders can be set
Show Time As: Free (clear), Tentative (Light Blue), Busy (Blue), Out of Office (Maroon)
Notes can be used to type in additional information
e Any day you see in bold on your calendar you have at least one appointment for that day

Changing appointment times
e Change Start time but keep length of appointment
e Hover over by the left colored bar of the appointment until a 4-directional arrow appears
and then hold the mouse down and drag the appointment to new starting time.
e Change length of appointment
Hover over the top or bottom of the appointment until a vertical bi-directional line
appears and then hold the mouse down and drag until desired duration of appointment

is obtained.
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Changing appointment dates
e Hover over the left colored bar of the appointment until a 4-directional arrow appears
and then hold the mouse down and drag to the new date. If the date isn’t showing,
drag up to the mini-calendars in the upper-right hand corner and release over the
desired date.

Copying appointments
e Hover over the left colored bar of the appointment until a 4-directional arrow appears
and then hold the CTRL key down and the mouse down and drag to the additional date.

Deleting appointments
e Hover over the left colored bar of the appointment until a 4-directional arrow appears
and then select the appointment and choose Delete from the keyboard or use the
toolbar button.

Setting up recurring appointments
e Set up the appointment as described above
Click on the Recurrence button
Create proper Recurrence Pattern
Specify Range of recurrence

Tasks
1. Navigating through Task View - Click on the Task folder to view the task pane
2. Creating new Tasks - Double click on the task pane, fill in the appropriate information for the
task
Editing Tasks
Deleting Tasks
Completing Task
Modify Task Pane View
e Go to View/Current View
e Choose Arrange By / Current View / Customize Current View
Select Field Chooser
Drag the Due Date Field to the TaskPad line it will show a red insertion point
Close Field Chooser
e Adjust width of due date field to see the entire field (drag at dividing line between the
words TaskPad & Due Date.
e Right Click on Due Date Heading and Sort Ascending.
e Right Click on Due Date heading and Group by this field.
e Right Click on Due Date heading and select Customize Current View
e Click OK when prompted

o v kw
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Top 10 Email Etiquette

10.

Use a Clear Subject Line — Make it easy for the recipient to understand the purpose of your
email.

Start and End Professionally — Begin with a polite greeting and end with a respectful closing, like
"Best regards."

Be Concise and On-Topic — Respect the recipient’s time by keeping the message brief and
focused.

Mind Your Tone — Avoid sarcasm, excessive caps, and casual language; strive for politeness and
clarity.

Proofread Before Sending — Check for grammar and spelling errors to ensure clarity and
professionalism.

Use “Reply All” Sparingly — Only include all recipients if necessary to avoid cluttered inboxes.
Attach Files and Links Thoughtfully — Mention attachments and links so recipients know where
to find them.

Respond Promptly — Aim to respond within 24-48 hours or acknowledge when you need more
time.

Use BCC When Needed — Protect recipients’ privacy by using BCC for large groups or unfamiliar
contacts.

Follow Up Respectfully — Wait a few business days before sending a gentle follow-up if you
haven't received a reply.

Schedule and Email:

1.

2.

Compose your email:

a. Open Outlook and create a new email by clicking New  »opers

Settings Security

Emall' Importance | Normal v II_\Q Change security settings for this message.
b. Fill in the recipient, subject, and message body as Seutiily 1oz ey S
[] Do not AutoArchive this item
usual. S
. D [[] use voting buttons K2
Set the Delivery Delay: ] Requet s delvery recipfor s messge
. . . [JRequest a read receipt for this message
a. Go to the Options tab in the message window. oy o ’ ’
H H H H Q Have replies sent to Select Names...
b. Click Delay Delivery (in the More Options group). £ D I — = _ =
c. Inthe Properties dialog that opens, check the box for Oewresaer v] [r200am v
. . Save copy of sent message
Do not deliver before and set the date and time you —
want the email to be sent. compres 7] [tone ‘

d. Click Close to save the settings, then click Send. The
email will stay in your Outbox until the scheduled time.

For Outlook Web (Outlook.com or Office 365 Web)

1.

2.

Compose your email:
a. Go to Outlook.com or your Office 365 account and start a new email.
b. Enter the recipient, subject, and message as usual.
Schedule Send:
a. Next to the Send button, click the dropdown arrow.
b. Select Send later.
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c. Choose the date and time you want the email to be sent.
d. Click Send to schedule the email.
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